
Novell®

novdocx (en)  13 M
ay 2009

AUTHORIZED DOCUMENTATION
Novell Compliance Management Platform Extension for SAP Environments 1.0 Overview
www.novell.com

Compliance Management Platform

1.0
May 29, 2009
Extension for SAP* Environments Overview



novdocx (en)  13 M
ay 2009
Legal Notices

Novell, Inc., makes no representations or warranties with respect to the contents or use of this documentation, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. 
Further, Novell, Inc., reserves the right to revise this publication and to make changes to its content, at any time, 
without obligation to notify any person or entity of such revisions or changes.

Further, Novell, Inc., makes no representations or warranties with respect to any software, and specifically disclaims 
any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc., 
reserves the right to make changes to any and all parts of Novell software, at any time, without any obligation to 
notify any person or entity of such changes.

Any products or technical information provided under this Agreement may be subject to U.S. export controls and the 
trade laws of other countries. You agree to comply with all export control regulations and to obtain any required 
licenses or classification to export, re-export or import deliverables. You agree not to export or re-export to entities on 
the current U.S. export exclusion lists or to any embargoed or terrorist countries as specified in the U.S. export laws. 
You agree to not use deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. See the 
Novell International Trade Services Web page (http://www.novell.com/info/exports/) for more information on 
exporting Novell software. Novell assumes no responsibility for your failure to obtain any necessary export 
approvals.

Copyright © 2009 Novell, Inc. All rights reserved. No part of this publication may be reproduced, photocopied, 
stored on a retrieval system, or transmitted without the express written consent of the publisher.

Novell, Inc., has intellectual property rights relating to technology embodied in the product that is described in this 
document. In particular, and without limitation, these intellectual property rights may include one or more of the U.S. 
patents listed on the Novell Legal Patents Web page (http://www.novell.com/company/legal/patents/) and one or 
more additional patents or pending patent applications in the U.S. and in other countries.

Novell, Inc.
404 Wyman Street, Suite 500
Waltham, MA 02451
U.S.A.
www.novell.com

Online Documentation: To access the latest online documentation for this and other Novell products, see 
the Novell Documentation Web page (http://www.novell.com/documentation).

http://www.novell.com/info/exports/
http://www.novell.com/company/legal/patents/
http://www.novell.com/documentation


novdocx (en)  13 M
ay 2009
Novell Trademarks

For Novell trademarks, see the Novell Trademark and Service Mark list (http://www.novell.com/company/legal/
trademarks/tmlist.html).

Third-Party Materials

All third-party trademarks are the property of their respective owners.

http://www.novell.com/company/legal/trademarks/tmlist.html


4 Novell

novdocx (en)  13 M
ay 2009
 Compliance Management Platform Extension for SAP Environments 1.0 Overview



Contents

novdocx (en)  13 M
ay 2009
About This Guide 7

1 Introduction 9
1.1 Terminology . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
1.2 Extension for SAP Environments Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

2 Meeting Prerequisites 13

3 Installing the Extension for SAP Environments Components 15
3.1 Installing the 3.0.1 Designer Auto Update . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
3.2 Installing the Updated iManager Plug-Ins for Identity Manager . . . . . . . . . . . . . . . . . . . . . . . . 15
3.3 Installing the Role Mapping Administrator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
3.4 Importing the Designer Project. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
3.5 Installing the Identity Manager Drivers for the extension for SAP environments . . . . . . . . . . . 16

3.5.1 Installing the Driver Files on the Metadirectory Engine . . . . . . . . . . . . . . . . . . . . . . . 17
3.5.2 Installing the Driver Files on the Remote Loader. . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

3.6 Installing the SAP Java Connector Client  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
3.7 Creating New Drivers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
3.8 Updgrade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Contents 5



6 Novell

novdocx (en)  13 M
ay 2009
 Compliance Management Platform Extension for SAP Environments 1.0 Overview



novdocx (en)  13 M
ay 2009
About This Guide

This guide provides an overview of the Novell® Compliance Management Platform extension for 
SAP environments.

Chapter 1, “Introduction,” on page 9
Chapter 2, “Meeting Prerequisites,” on page 13
Chapter 3, “Installing the Extension for SAP Environments Components,” on page 15

Audience

This guide is intended for partners, consultants, and customers who are very familiar with the 
products in the Novell Compliance Management Platform extension for SAP environments.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.

Documentation Updates

For the most recent version of the Novell Compliance Management Platform Extension for SAP 
Environments Overview, visit the Novell Compliance Management Platform Extension for SAP 
Environments Documentation Web site (http://www.novell.com/documentation/ncmp_sap10).

Additional Documentation

For documentation on the Novell Compliance Management Platform, see the Novell Compliance 
Management Platform Documentation Web site  (http://www.novell.com/documentation/ncmp10/
index.html).

For documentation on the Role Mapping Administrator, see the Identity Manager Role Mapping 
Administration Installation and Configuration Guide (http://www.novell.com/documentation/
ncmp_sap10/index.html)

Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for 
other platforms, the pathname is presented with a backslash. Users of platforms that require a 
forward slash, such as Linux* or UNIX*, should use forward slashes as required by your software.
About This Guide 7
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1Introduction

The extension for SAP environments is an add-on to the Novell® Compliance Management 
Platform product. The Compliance Management Platform helps you to mitigate risk, simplify 
business governance, and ensure compliance throughout the enterprise. The extension for SAP 
environments simplifies the management of complex SAP systems.

The extension for SAP environments requires the Compliance Management Platform to be installed 
and configured. For more information about the Compliance Management Platform, see the Novell 
Compliance Management Platform Integration Guide (http://www.novell.com/documentation/
ncmp_sap10/index.html).

Section 1.1, “Terminology,” on page 9
Section 1.2, “Extension for SAP Environments Components,” on page 10

1.1  Terminology
This section gives you essential information about terminology used with SAP. If you need further 
help with SAP terminology, see the Glossary for the SAP Library (http://help.sap.com/saphelp_46c/
helpdata/En/35/2cd77bd7705394e10000009b387c12/frameset.htm).

ABAP: Advanced Business Application Programming. A programming language designed for 
creating large-scale business applications. 

BAPI: SAP Business APIs for the SAP business object types.

CCMS: Computer Center Management System.

CUA: Central User Administration.

ERP: Enterprise Resource Planning.

GRC: Governance, Risk, and Compliance.

IDocs: Intermediate Documents. A data exchange format used between SAP systems as well as 
between SAP systems and external applications.

R/3: The former name of the ERP.

SPML: Service Provisioning Markup Language. An XML-based framework for managing the 
provisioning and allocation of identity information and system resources within and between 
organizations.

UME: User Management Engine.

XAL: External interface for Alert Management.
Introduction 9
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1.2  Extension for SAP Environments 
Components
The extension for SAP environments is not a single product, but consists of multiple products and 
solutions.

 Business solutions that address the complexities of managing SAP systems
New and updated SAP Identity Manager drivers
A new Web application for managing roles, groups, and profiles called the Identity Manager 
Role Mapping Administrator
A new Sentinel Connector, Collector, and Solution Pack for SAP

The extension for SAP environments uses the different components to solve business problems. The 
following figure shows how the different components work together.

Figure 1-1   Components of the extension for SAP environments

The different components of the extension for SAP environments are:

Identity Manager Driver for SAP Business Logic: The SAP Business Logic driver processes the 
business logic in your SAP environment. It is used with SAP HR driver to provision users in SAP 
HR systems that have an organizational management structure instead of a flat file structure.

For additional information about the SAP Business Logic driver, see the Identity Manager Driver 
for SAP Business Logic Implementation Guide (http://www.novell.com/documentation/
ncmp_sap10/sap_business/data/index.html).

Identity Manager Driver for SAP GRC Access Control: The SAP GRC Access Control driver 
provisions users from the GRC Access Control into the Identity Vault. If you have other SAP drivers 
configured, they can pick up accounts from GRC Access Control to populate the other SAP systems.

For more information about the SAP GRC Access Control driver, see the Identity Manager Driver 
for SAP GRC Access Control Implementation Guide (http://www.novell.com/documentation/
ncmp_sap10/sap_grc/data/index.html)

Identity Vault

SAP App
Servers

SAP
GRC

SAP
Portal

Roles Based Provisioning Module

Sentinel 

Role Mapping
Administrator

Access Manager

Single
Sign-On
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Identity Manager Driver for SAP HR: The SAP HR driver creates HR records in the SAP ERP 
systems. If you have an organizational management structure in the ERP system, you must use the 
SAP Business Logic driver with the SAP HR driver to manage this configuration.

For information about the SAP HR driver, see the Identity Manager Driver for SAP HR 
Implementation Guide (http://www.novell.com/documentation/idm36drivers/sap_hr/data/
bktitle.html).

Identity Manager Driver for SAP Portal: The SAP Portal driver provisions users to the SAP 
NetWeaver* Application Server. 

For more information, see the Identity Manager Driver for SAP Portal Implementation Guide (http:/
/www.novell.com/documentation/ncmp_sap10/sap_portal/data/bktitle.html).

Identity Manager Driver for SAP User Management: The SAP User Management driver 
provisions users to SAP CUA and R/3 systems. The SAP User Management driver has fan-out 
capabilities that let you set up and configure one driver to manage multiple SAP clients.

For information about the SAP User Management driver, see the Identity Manager Driver for SAP 
User Management Implementation Guide (http://www.novell.com/documentation/idm36drivers/
sap_user/data/aazjth1.html).

Identity Manager Role Mapping Administrator: The Role Mapping Administrator is a Web 
application that lets you map roles, composite roles, and profiles (collectively referred to as 
authorizations) to Identity Manager roles.

For more information about the Role Mapping Administrator, see the Identity Manager Role 
Mapping Administration Installation and Configuration Guide (http://www.novell.com/
documentation/ncmp_sap10/role_mapping_installation/data/index.html).

Sentinel Collector for SAP CCMS: The SAP CCMS Collector, which is a SAP Certified product, 
parses the data from SAP systems into SentinelTM so that you can use the Solution Pack for SAP to 
generate reports and set up alerts.

For more information about the Sentinel Collector for SAP CCMS, see the Sentinel Content Web 
site (http://support.novell.com/products/sentinel/secure/sentinel61.html) and the Novell Compliance 
Management Platform extension for SAP environments Solutions Guide (http://www.novell.com/
documentation/ncmp_sap10/sap_solutions/data/index.html).

Sentinel Connector for SAP XAL: The SAP XAL Connector facilitates the connectivity between 
the SAP CCMS Collector and the SAP systems.

For more information about the Sentinel Connector for SAP XAL, see the Sentinel Content Web site 
(http://support.novell.com/products/sentinel/secure/sentinel61.html) and the Novell Compliance 
Management Platform extension for SAP environments Solutions Guide (http://www.novell.com/
documentation/ncmp_sap10/sap_solutions/data/index.html).

Sentinel Solution Pack for SAP:  The Solution Pack for SAP provides controls (views and reports) 
of events associated with users in your SAP system. Through these controls, you can monitor and 
report on account management activities (creation, deletion, and modification); suspicious user 
activities such as failed authentication, denied access, denied or increased account privileges, and 
impersonated account logins; account usage by users; and password management activities. Because 
of the identity injection provided by the Sentinel driver and Identity Vault collector, events are 
associated to individual users.
Introduction 11
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For more information about the Sentinel Solution Pack, see the Sentinel Content Web site (http://
support.novell.com/products/sentinel/secure/sentinel61.html) and the Novell Compliance 
Management Platform extension for SAP environments Solutions Guide (http://www.novell.com/
documentation/ncmp_sap10/sap_solutions/data/index.html).

SAP Business Solutions: The extension for SAP environments includes documentation for 
solutions that address common business problems by using the components of the extension for SAP 
environments.

For information about the SAP Business Solutions, see the Novell Compliance Management 
Platform extension for SAP environments Solutions Guide (http://www.novell.com/documentation/
ncmp_sap10/sap_solutions/data/index.html).
 Compliance Management Platform Extension for SAP Environments 1.0 Overview
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2Meeting Prerequisites

The extension for SAP environments consists of many different products. In order to implement the 
extension for SAP environments solutions, the following prerequisites must be met:

Install and configure the Compliance Management Platform 1.0. The one exception is that 
Access Manager has been updated to Access Manager 3.1. All of the extension for SAP 
environments solutions are built using Access Manager 3.1.

 For more information, see the Novell Compliance Management Platform1.0 Integration 
Guide.
The new and updated Identity Manager driver configurations for SAP use structured GCVs. 
You must have updated iManager plug-ins and an updated Designer in order to manage these 
new drivers. For instructions, see Chapter 3, “Installing the Extension for SAP Environments 
Components,” on page 15.
Meeting Prerequisites 13
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3Installing the Extension for SAP 
Environments Components

Before you begin installing the components, make sure you have installed and configured the 
Compliance Management Platform 1.0, with the exception of installing Access Manager 3.1 instead 
of Access Manager 3.04. For more information, see the Novell Compliance Management 
Platform1.0 Integration Guide.

Section 3.1, “Installing the 3.0.1 Designer Auto Update,” on page 15
Section 3.2, “Installing the Updated iManager Plug-Ins for Identity Manager,” on page 15
Section 3.3, “Installing the Role Mapping Administrator,” on page 16
Section 3.4, “Importing the Designer Project,” on page 16
Section 3.5, “Installing the Identity Manager Drivers for the extension for SAP environments,” 
on page 16
Section 3.6, “Installing the SAP Java Connector Client,” on page 18
Section 3.7, “Creating New Drivers,” on page 19
Section 3.8, “Updgrade,” on page 19

3.1  Installing the 3.0.1 Designer Auto Update
In order to manage drivers with structured GCVs, you must install the 3.0.1 Designer Auto Update 
(AU).

1 From the Designer 3.0.1 toolbar, select Help > Check for Designer Updates.
2 Follow the prompts to complete the installation.
3 Click Yes to restart Designer.

Designer must be restarted for the changes to take effect.

3.2  Installing the Updated iManager Plug-Ins for 
Identity Manager
In order to manage drivers with structured GCVs, you must install the updated iManager plug-ins.

1 Launch iManager and log in as an administrative user.
2 From the toolbar, click the Configure icon .
3 Click Plug-in Installation > Available Novell Plug-in Modules.
4 Select, then click Install.
5 Select I Agree in the license agreement, then click OK.
6 After the installation completes, click Close twice.
7 Log out of iManager and restart Tomcat to have the changes take effect.
Installing the Extension for SAP Environments Components 15
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or

1 If the  are not in the list, download the Identity Manager 3.6.1 plug-ins for iManager 2.7 from 
the Novell product download Web site (http://download.novell.com) to your iManager server.

2 Launch iManager and log in as an administrative user.
3 From the toolbar, click the Configure icon .
4 Click Plug-in Installation > Available Novell Plug-in Modules.
5 Click Add.
6 Browse to and select the Identity Manager .npm file, then click OK.
7 After the installation completes, click Close twice.
8 Log out of iManager and restart Tomcat to have the changes take effect.

3.3  Installing the Role Mapping Administrator
The Role Mapping Administrator is an application that comes with the extension for SAP 
environments that allows you to manage your business roles and IT roles from the same location. 
For installation and configuration instructions, see the Identity Manager Role Mapping 
Administrator 1.0 Installation and Configuration Guide.

3.4  Importing the Designer Project
The extension for SAP environments provides a Designer project that contains all of the new and 
updated drivers installed and configured. You can import and use the Designer project as starting 
point for implementing the extension for SAP environments solutions.

1 Download the eSe_project.zip file that contains the Designer project from the Novell 
Compliance Management Platform Extension for SAP Environments product Web site (http://
download.novell.com/Download?buildid=8o_N7mVgOVo~).

2 Launch Designer.
3 From the toolbar, click Project > Import Project > File System.
4 Browse to and select the downloaded project, then click OK.
5 Verify that the extension for SAP environments project is listed under Projects, and that the 

Copy project into the workspace option is selected.
6 Click Finish.

3.5  Installing the Identity Manager Drivers for the 
extension for SAP environments
The extension for SAP environments contains new and updated SAP drivers. You must install these 
new and updated drivers in order to implement the extension for SAP environments solutions. The 
installer installs the following drivers:

Driver for SAP Business Logic
Driver for SAP GRC Access Control
Driver for SAP Portal
Driver for SAP User Management
 Compliance Management Platform Extension for SAP Environments 1.0 Overview
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The installer installs the correct files, extends the schema for the Identity Vault, and installs utilities 
for the drivers.

Complete one or both of the following sections to install the drivers, depending upon your 
environment: 

Section 3.5.1, “Installing the Driver Files on the Metadirectory Engine,” on page 17
Section 3.5.2, “Installing the Driver Files on the Remote Loader,” on page 17

3.5.1  Installing the Driver Files on the Metadirectory Engine
1 Download the NIdM_Drivers_for_CMP_Extension_for_SAP.iso from the Novell 

Compliance Management Platform Extension for SAP Environments product Web site (http://
download.novell.com/Download?buildid=8o_N7mVgOVo~).

2 In the NIdM_Drivers_for_CMP_Extension_for_SAP.iso file, use the correct installation 
program for your platform located:

If you are installing on a Linux/UNIX platform, you must run the install as the user that 
installed Identity Manager. For example, if you installed Identity Manager as root, you must 
run this installer as root.

3 Read the welcome message, then click Next.
4 Read and accept the license agreement, then click Next.
5 Select Drivers and Schema Extensions.

The installation program detects the installation location of the Metadirectory engine and 
places the driver files in this location.

6 Specify the LDAP DN of an administrative user of the Identity Vault. The administrative user 
must have administrative rights to the root of the Identity Vault in order to extend the schema. 

7 Specify the password of the administrative user, then click Next.
8 Review the summary screen, then click Install.
9 Review the Installation Complete message, then click Done.

3.5.2  Installing the Driver Files on the Remote Loader
1 Download the NIdM_Drivers_for_CMP_Extension_for_SAP.iso from the Novell 

Compliance Management Platform Extension for SAP Environments product Web site (http://
download.novell.com/Download?buildid=8o_N7mVgOVo~).

2 Use the correct installation program for your platform located on the 
NIdM_Drivers_for_CMP_Extension_for_SAP.iso file:

Platform File

Windows* cmpes_driver_install.exe

Linux ./cmpes_driver_install_linux.bin

Solaris* ./cmpes_driver_install_solaris.bin

AIX* ./cmpes_driver_install_aix.bin
Installing the Extension for SAP Environments Components 17
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3 Read the welcome message, then click Next.
4 Read and accept the license agreement, then click Next.
5 Select Drivers and Utilities, then click Next.

If you are installing the Remote Loader on a server without the Identity Vault, the Schema 
Extensions option is not select. The schema extensions are only for the Identity Vault.

6 Specify the installation location of the lib directory for the drivers. The default location is:

7 Click Next.
8 Specify the installation location of the utilities. The default location is:

9 Click Next.
10 Review the summary screen, then click Install.
11 Review the Installation Complete message, then click Done.

3.6  Installing the SAP Java Connector Client
The server where the SAP User Management driver is installed must have the SAP Java* Connector 
(JCO) client version 3 installed to provide the driver with connectivity the SAP system. The updated 
SAP User Management driver that comes with the extension for SAP environments only supports 
JCO version 3.

This JCO client is available to SAP customers and developer partners through SAP, and is provided 
for most popular server operating systems. You can download the JCO from the SAP Connectors 
site (http://service.sap.com/connectors).

Platform File

Windows cmpes_driver_install.exe

Linux ./cmpes_driver_install_linux.bin

Solaris ./cmpes_driver_install_solaris.bin

AIX ./cmpes_driver_install_aix.bin

Platform Location

Windows c:\Novell\RemoteLoader\lib

Linux/UNIX /opt/novell/eDirectory/lib/dirxml

Platform Location

Windows c:\Novell\NDS\DirXMLUtilities

Linux/UNIX /opt/novell/eDirectory/lib/dirxml
 Compliance Management Platform Extension for SAP Environments 1.0 Overview
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3.7  Creating New Drivers
After the driver files are installed on the server where you want to run the drivers, you can create the 
drivers in the Identity Vault. You do so by importing the basic driver configuration file and then 
modifying the driver configuration to suite your environment. For instructions, see each individual 
driver guide.

Identity Manager 3.6 Driver for SAP Business Logic Implementation Guide
Identity Manager 3.6 Driver for SAP GRC Access Control Implementation Guide
Identity Manager 3.6 Driver for SAP Portal Implementation Guide
Identity Manager 3.6 Driver for User Management of SAP Software Implementation Guide

3.8  Updgrade
The SAP User Management (JCo 3) driver is has significant changes for this release. The changes 
do not make it possible to upgrade the driver. If you want to use the new features in the driver, the 
supported process is as follows:

1. Create a new driver in the same driver set as the old driver. 
2. Move any custom policies from the old driver to the new driver.
3. Stop the old driver.
4. Start and test the new driver.
5. After everything is working with the new driver, delete the old driver.

For more information about the new features in the SAP User Management (JCo 3) driver, see 
“What’s New” in the Identity Manager 3.6 Driver for SAP User Managment (JCo 3) 
Implementation Guide
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